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Onboard SCSI RAID User’s Guide

Areas Covered

Before Reading This Manual

This section explains the notes for your safety and conventions used in this manual.

Chapter 1 Overview

This chapter explains an overview of the disk array configurable with the onboard SCSI array 
controller.

Chapter 2 Installing Global Array Manager (GAM)

This chapter explains how to install Global Array Manager (GAM) .  

Chapter 3 How to Use GAM

 GAM is a basic utility to manage the disk array. Read this chapter carefully before use. 

Chapter 4 Replacing a Hard Disk

This chapter explains maintenance related issues, such as hard disk replacement. 

Appendix

This appendix explains the list of GAM error codes.
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Before Reading This Manual

Remarks

■ Symbols
Symbols used in this manual have the following meanings.

■ Key Descriptions / Operations 
Keys are represented throughout this manual in the following manner. 
E.g.: [Ctrl] key, [Enter] key, [→] key, etc.
The following indicate pressing several keys at once: 
E.g.: [Ctrl] + [F3] key, [Shift] + [↑] key, etc.

■ Entering Commands (Keys)
Command entries are displayed in the following way. 

• In the areas of the "↑" mark, press the [Space] key once. 
• When using Windows or DOS OS, commands are not case sensitive.
• CD-ROM drive names are shown as [CD-ROM drive]. Enter your drive name according to your 

environment. 
[CD-ROM drive]:\setup.exe

■ Screen Shots and Figures
Screen shots and figures are used as visual aids throughout this manual. Windows, screens, and file 
names may vary depending on the OS, software, or configuration of the server used. Figures in this 
manual may not show cables that are actually connected for convenience of explanation. 

■ Consecutive Operations
Consecutive operations are described by connecting them with arrows (→). 

These sections explain prohibited actions and points to note when using this device. Make 
sure to read these sections. 

These sections explain information needed to operate the hardware and software properly. 
Make sure to read these sections. 

→ This mark indicates reference pages or manuals. 

Example: Procedure of clicking the [Start] button, pointing to [Programs], and clicking [Accessories]
↓
Click [Start] → [Programs] → [Accessories].
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■ Trademarks
Microsoft, Windows, and Windows Server are trademarks or registered trademarks of Microsoft Corporation in the USA
and other countries.
Linux is a trademark or registered trademark of Linus Torvalds in the USA and other countries.
Red Hat and all Red Hat-based trademarks and logos are trademarks or registered trademarks of Red Hat, Inc. in the
USA and other countries.
All other hardware and software names used are trademarks or registered trademarks of their respective manufacturers. 
Other product names are copyrights of their respective manufacturers. 

All Rights Reserved, Copyright© FUJITSU LIMITED 2006

Screen shot(s) reprinted with permission from Microsoft Corporation.
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Chapter 1

Overview

This chapter explains an overview of the disk 
array configurable with the onboard SCSI 
controller.

1.1 Disk Array Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . 8
1.2 Notes on Array Configuration and Operation  . . . . . . . . . . 12
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Chapter 1　Overview

1.1 Disk Array Configuration

A disk array or RAID (Redundant Array of Independent Disks) is a system using a 
disk controller and multiple hard disk units that achieves better performance and 
higher reliability than just a single hard disk unit.
The disk controller controls the access to each hard disk unit. Thanks to its 
redundancy feature, the system can keep operating without loss of data, even if a 
failure should occur with one of the hard disk units.

1.1.1 RAID Level

Among the several RAID levels, the onboard SCSI array controller of this server supports only RAID1.
In RAID1, the maximum number of hard disk units, the available total capacity, and the redundancy 
feature are defined as follows:
• Maximum number of hard disk units: 2
• Available total capacity: Capacity of one hard disk unit
• Redundancy feature: Yes

To prepare for unexpected problems, back up the data frequently.
Even for a system that can contain three or more hard disk units, only two hard disk units can be used 
in RAID1.

■ RAID1 - Mirroring
Mirroring is a function in which identical data is written in two hard disk units in duplicate. With this 
function, even if one hard disk unit should fail, the system can keep operating using the other hard disk 
unit. RAID1 provides high reliability by utilizing the redundancy feature of mirroring and the actual 
available capacity is equal to the capacity of one hard disk unit.

Hard Disk 2

Hard Disk 1

Onboard SCSI
array controller

Data
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1.1.2 Logical Drive

A logical drive is a virtual drive consisting of multiple hard disk units.
The OS recognizes it as if it were a single hard disk drive. The RAID level needs to be configured for 
each logical drive.
The onboard SCSI array controller of this server supports only one logical drive.
In the figure below, the RAID1 disk array consists of two hard disk units. The OS recognizes the array as 
if one hard disk unit was connected.

As for the status of the logical drive, "Online" represents the normal state, "Critical" means a state where 
one hard disk unit has a failure and the redundancy feature is inactive, and "Offline" means a state where 
both of hard disk units have failures and the logical drive is inactive.

■ Initialization of a Logical Drive
When you have just created a logical drive, the data in the two hard disk units may not be identical. You 
need to make the data in the two hard disk units identical by initializing the logical drive.
This server's onboard SCSI array controller executes "Rebuild" for the logical drive initialization, 
automatically when creating a logical drive.

During the initialization, the hard disk failure LEDs blink on the front of the initialized hard disk units 
during the OS operation. Also, when ServerView is installed, the System ID LED light up on the front 
and the back of the server. After the initialization is completed, these LEDs turn off automatically.
When resetting the server or turning off the power before the initialization is completed, the 
initialization is halted. Upon restarting the server, the initialization resumes from the block where it was 
interrupted, so that the initialization continues over the reset and the power-off.
To confirm the initialization status, select [Logical drive info] from [Controller View] in the GAM Utility. If 
[Online] is displayed in [Status], the initialization is completed. If [Critical] is displayed, the initialization 
is still in progress. For more details, refer to "3.5.4 Displaying Logical Drive Information" ( pg.44).

Logical Drive 0

Hard Disk 1 Hard Disk 2
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● Notes on Initialization of Logical Drives

Before the initialization is completed, the logical drive may not achieve sufficient I/O performance 
compared to an initialized drive. There are no problems with accessing to the hard disk drive, but the 
access speed will be slower. At the maximum, the speed is degraded to about 54%. From the array 
configuration until the initialization is complete, the array is in the non-redundancy state.  Therefore, do 
not start the system operation or store valuable data before the array construction is finished.
The estimated time required for the initialization is as follows. If the initialization does not finish in over 
twice the estimated time, contact an office listed in the "Contact Information" of "Start Guide".

The estimated time above is the total time during OS operation and does not include the power-off 
period in between.  If ordinary I/O occurs during the initialization, it may take longer.
The time may vary depending on the configuration and the model of the hard disk units. Use the 
estimated time only as a reference.
After the initialization is completed, the RAID1 logical drive maintains its redundancy.

● Time Required for Completing "Rebuild"

Without ordinary I/O, the execution time for "Rebuild" is approximately 5.2 min/GB. For example, when a 
RAID1 logical drive is configured with two 146.8GB hard disk units, the "Rebuild" execution takes about 
763 minutes ( ≒ 5.2 min/GB x 146.8GB, i.e. approx. 13 hrs). When ordinary I/O occurs during "Rebuild", 
it may take longer. The time may vary depending on the configuration and the model of the hard disk units. 
Use the estimated time only as a reference.

1.1.3 Media Verification

Media verification is a function that detects and corrects media errors in hard disk units in advance. This 
server's onboard SCSI array controller always performs media verification when the logical drive is in 
the Online state.
If there is a media error in a hard disk unit other than the failed hard disk unit during "Rebuild", data 
cannot be recovered after "Rebuild". Media verification reduces the risk of data loss at "Rebuild", by 
correcting media errors in advance.

table: Estimated time required for the initialization
Capacity of

the hard disk unit
Estimated time required for the initialization

(w/o ordinary I/O)

73GB Approx. 6.5 hrs

147GB Approx. 13 hrs

300GB Approx. 26 hrs
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1.1.4 Hard Disk Failure Prediction Function (S.M.A.R.T.)

The hard disk has a S.M.A.R.T. function. With this function, the hard disk predicts a failure and gives 
you prior warning when there is a high possibility of a failure.
The hard disk works normally even when the S.M.A.R.T. is issued. However, early replacement of the 
hard disk is recommended to avoid a future failure. For information on how to replace the hard disk, 
refer to "4.3 Preventive Replacement Procedure of a Hard Disk" ( pg.52).
The onboard SCSI array controller of this server issues S.M.A.R.T. and it can be checked on any of the 
following.
• System event log (GAM ID=4)
• GAM Utility
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1.2 Notes on Array Configuration and 
Operation

This section explains how to configure an array with the onboard SCSI array 
controller and notes on the array operation.

1.2.1 Array Configuration

Before installing the OS in the server, configure an array with the SCSI Setup Utility. For details, refer to 
"Chapter 8 Configuring Hardware and Utilities" in the "User's Guide". Also, after the OS installation, 
install GAM (Global Array Manager) which is the RAID Management Tools. For details on how to 
install GAM, refer to "2.2.1 How to Install GAM" ( pg.17).

1.2.2 Hard Disk Units to Be Used

Check the following notes on hard disk units in advance.
• Before configuring an array, make sure that two hard disk units of the same model (with the same 

capacity and the same rotation speed) are installed.
• Hard disk units that have been used before may have unwanted partition information or array 

configuration information. Using such units without taking the proper measures may cause 
unexpected problems. If you connect any hard disk units with usage history to this server, format 
them at low level on another system in advance.

• In the state with the power supply of the server, do not remove the hard disk unit except when you 
replace the failed hard disk (you can only remove the hard disk with the Dead status when the power 
of the server is on).

1.2.3 Notes on RAID1 Operation

When operating in RAID1 array configuration, the system always writes the same data in two hard disk 
units, using the redundancy feature. Even if one hard disk unit has a failure (i.e. the "Critical" state), 
operation is maintained.
However, when two hard disks have failed, the system does not start and data is lost. 
If the logical drive falls into the "Critical" state, replace the failed hard disk unit and execute "Rebuild" to 
restore the "Online" state as soon as possible.

Rebuild

"Rebuild" is a process in which data are copied from the functioning hard disk unit to the replaced hard 
disk unit, in order to restore the data redundancy. When executing "Rebuild", the logical drive in the 
"Critical" state turns back to the "Online" state.
For details on how to replace the hard disk unit, refer to "4.2 Replacing a Hard Disk" ( pg.51).
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■ When a Hard Disk Failure Is Detected at Startup
If a hard disk failure is detected when starting the system, the following error message is displayed at the 
POST screen and the startup pauses.

In this case, confirm the state of the hard disk by using an attached "Onboard RAID Utility". For details 
on how to confirm it, refer to "9.2.3 Software Troubleshooting" in "User's Guide".

Warning!: The array is degraded.  Press [Ctrl] [A] to continue after 
insert Floppy Disk.
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Installing Global Array 
Manager (GAM)

This chapter explains how to install Global Array 
Manager (GAM) . 

2.1 Overview / Product Requirements  . . . . . . . . . . . . . . . . . . 16
2.2 Installing GAM . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
2.3 Using GAM in a Linux Environment . . . . . . . . . . . . . . . . . 24
2.4 Using GAM in a Multiple Server Environment . . . . . . . . . . 25
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2.1 Overview / Product Requirements

This section explains Global Array Manager (hereafter referred to as GAM).

2.1.1 GAM Overview

GAM is an application that allows you to manage a disk array system connected to a SCSI array 
controller . 
The functions of GAM are accomplished by the interaction of GAM Client with GAM Server. 
• Monitoring function

GAM Server collects information about the status and resource usage of disk arrays and notices 
them. 

• Management function
GAM Client provides fault management, highly reliable messaging process, and excellent OS 
support. GAM Client also manages maintenance of each disk array and hard disk and provides an 
intuitive GUI.

To ensure stable operation of PRIMERGY, install the GAM when using the onboard SCSI array 
controller. The hard disk status cannot be monitored with the system operates when GAM is not 
installed. For instance, the system down and the loss of data are caused due to leaving one hard disk 
breakdowns. Install the GAM to detect malfunction at the stage where one hard disk breaks down.

2.1.2 Requirements for GAM

An appropriate server environment is required for using GAM Server and GAM Client properly. Use 
hardware and software that meet the following conditions to create an environment best suited for use: 
• OS: Windows Server 2003, Windows 2000 Server, Linux
• Hard disk free space: 20MB or more
• TCP/IP, SNMP service, and ServerView must be installed

Apply the latest Service Pack to each OS.
Make sure to install the specified drivers and GAM.
Configure network settings properly. If the network settings are not proper, it may not be possible to 
monitor the array status by ServerView, or events may not be noticed.

Disk arrays are monitored by OS event logs that are noticed by ServerView. Because events that are 
noticed from GAM (source: gamevlog) are not supported, ignore the events recorded by "gamevlog". If 
any logs for a SCSI array controller are noticed by ServerView before or after the event, view the logs. 
For the list of logs noticed by ServerView, refer to "Appendix A List of GAM Error Codes" ( pg.56).
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2.2 Installing GAM

This section explains how to install GAM.

GAM cannot be overwrite-installed. Make sure to uninstall the existing GAM before reinstalling GAM. 
Depending on your system configuration, the SNMP service may be stopped after installing or 
uninstalling GAM. Restart the OS after installing or uninstalling GAM. 
During GAM installation, you may be prompted to enter appropriate information. In such cases, follow 
the window instructions to proceed.
During GAM installation, if the error "Could not stop Snmp service. Installation will not continue." 
occurs and the installation cannot be completed, reinstall GAM. If the same error occurs again, stop 
the SNMP service and reinstall GAM. 
The following message may pop up when the system is restarted immediately after installing/
uninstalling GAM if Service Pack 1 for Windows Server 2003 is applied.  

This does not pose any problem to operation. Click [Close Message] to close the message.
For Windows Server 2003 or Windows 2000 Server, if you install GAM right after the OS startup, an 
error may occur when stopping the SNMP service and the following error information may be logged in 
the OS event log. This does not happen when installing GAM more than five minutes after the OS 
startup.

Since there are no operation problems with this OS event log, continue the installation procedure and 
reboot the system after the installation.

2.2.1 How to Install GAM

Perform the following procedure to install GAM.

To record events occurring to the OS event logs, install ServerView and configure the event logging 
settings. For details, refer to "ServerView User’s Guide".

1 Log on with administrator privileges. 

This program was terminated by Windows for the security of the computer. 
    Name:     SNMP Service

Type : Error
Source : Service Control Manager
Description: The SNMP Service service terminated unexpectedly.
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2 Before installing GAM, complete the following preparation: 
• Check that TCP/IP is installed and working properly. 
• Check that ServerView is installed and working properly. 
• Exit all applications. 

Exit all applications before starting installation. Especially, if you install GAM while Event 
Viewer or Computer Management is running, the installation may fail. 

3 Insert the SCSI Array Controller Document & Tool CD V6.0L10 and click [Start] 
→ [Run...]. Enter the following path and click [OK].

[CD-ROM drive] :\RAIDTOOL\GAM\Windows\install.bat
The Global Array Manager Setup wizard starts up.

4 In the [Welcome] window, click [Next]. 
The [Software License Agreement] window appears. 

5 Click [Yes]. 
The [Select Components] window appears. 
Make sure the boxes next to [Global Array Manager Server] and [Global Array Manager Client] 
are checked. 
Uncheck [SANArray Manager Client].

Do not install SANArray Manager Client because it is not supported. 
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6 Select [Global Array Manager Server] and click [Change]. 
The [Select Sub-components] window appears. 

Make sure [Program Files] and [SNMP] are checked. If any items other than [Program Files] and 
[SNMP] are displayed, uncheck them. 

7 Click [Continue] after confirmation.
The [Select Components] window appears again. 

8 Click [Next]. 
The [Choose Destination Location] window appears. 

When GAM Server has already been installed, a message will appear to confirm the overwrite.
Click [Cancel ] to stop installation. Check the message that will appear after stopping installa-
tion and perform the operation of step 15 and 16. Uninstall the existing GAM, restart the sys-
tem and reinstall GAM.

9 Click [Next]. 
The installation location for GAM is displayed. 

When GAM Client has already been installed, a message will appear to confirm the overwrite.
Click [Cancel ] to stop installation. Check the message that will appear after stopping installa-
tion and perform the operation of step 15 and 16. Uninstall the existing GAM, restart the sys-
tem and reinstall GAM.

10 Confirm the installation location and click [Next]. 
File copying starts.
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If the following window appears, GAM has already been installed. Cancel this procedure and
install GAM again after uninstalling.

11 Specify the client receiving events from GAM Server. 
In the text box, enter the computer name on which GAM Client is being installed and click 
[Next]. 

The [Server Event Logging] window appears. 

If GAM Client and GAM Server are installed on the same computer, enter the name of the
server. 
If the IP address or computer name of Client is changed after GAM Server was installed,
events cannot be noticed correctly. In this case, GAM Server needs to be uninstalled first and
then installed again. (If the IP address is automatically obtained from the DHCP server, the IP
address may be changed depending on the timing of powering on/off or restarting the system.) 
To specify multiple clients receiving events, enter the computer names or IP addresses of serv-
ers, each separated by space. It is possible to specify up to 25 clients receiving events at a
time. 
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12 Make sure [Enable event logging on the server machine] is checked and click 
[Next]. 

This option must be enabled. 

13 When the full pathname of the configuration file appears, click [OK]. 
The [Setup Complete] window appears. 

14 Click [Finish] to exit the GAM installation wizard. 

15 Press the [Enter] key if the message appears on the command prompt to 
indicate that the setup has started. 

16 Press the [Enter] key if the message appears on the command prompt to 
indicate that the installation has been completed. 
The command prompt is closed.

17 Restart the system.

18 Create the user account "gamroot" for GAM administrator privileges and a user 
account for GAM user privileges (e.g. gamuser) as Windows user accounts. 
Assign the user account "gamroot" to the Administrators group. 

Create each user account as an OS user account. 
When creating the account for GAM administrator privileges, uncheck the “User must change
password at next logon“. 
Also, check the “Password never expires“.
If not making the above settings, you may not be able to log on to GAM. 

2.2.2 Local Logon Setting on a Domain Controller

If Windows Server 2003 or Windows 2000 Server is used as a domain controller, it is necessary to set 
the local logon rights to the user account with which you log on to GAM. 
Configure the setting according to the following procedure. 

Attempting to log on to GAM with a user account that does not have the local logon rights will fail even 
if the user name and password are entered correctly. 

1 Click [Start] → [Programs] → [Administrative Tools] → [Domain Controller 
Security Policy]. 
The [Domain Controller Security Policy] window appears.

2 Double-click [Security Settings]. 
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3 Double-click [Local Policies]. 

4 Double-click [User Rights Assignment]. 

5 Double-click [Log on locally]. 
The [Security Policy Setting] window appears. 

6 Click [Add].

7 Click [Browse]. 

8 Select the user account with which is to be logged on to GAM and click [Add]. 

9 Click [OK].

10 Click [OK].
The [Add User or Group] window closes.

11 Click [OK].
The [Security Policy Setting] window closes.

12 Open [Command Prompt] and run the following command. 
• For Windows Server 2003

• For Windows 2000 Server 

2.2.3 How to Uninstall GAM

Perform the following procedure to uninstall GAM. 

Do not uninstall GAM Server/GAM Client during normal use. 

■ Uninstalling GAM Client

1 Log on with administrator privileges. 

Before uninstalling GAM, exit all programs. If uninstalling GAM while Event Viewer or Com-
puter Management is running, the uninstallation will fail. 

2 Click [Start] → [Settings] → [Control Panel]. 

C:\>gpupdate

C:\>secedit /refreshpolicy MACHINE_POLICY
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3 Start [Add or Remove Applications] or [Add or Remove Programs].

4 Select [Mylex Global Array Manager Client v.n.nn-nn] from the application list 
and click [Change/Remove]. 
The message "Are you sure you want to completely remove 'Mylex Global Array Manager Client 
vn.nn-nn' and all of its components?" appears. 

5 Click [Yes].
Uninstallation process starts. 

6 When the uninstallation completes, click [OK]. 

■ Uninstalling GAM Server

1 Log on with administrator privileges. 

Before uninstalling GAM, exit all programs. If uninstalling GAM while Event Viewer or Com-
puter Management is running, the uninstallation will fail. 

2 Click [Start] → [Settings] → [Control Panel]. 

3 Start [Add or Remove Applications] or [Add or Remove Programs].

4 Select [Mylex Global Array Manager Server v.n.nn-nn] from the application list 
and click [Change/Remove]. 
The message "Are you sure you want to completely remove 'Mylex Global Array Manager 
Server vn.nn-nn' and all of its components?" appears. 

5 Click [Yes].
Uninstallation process starts. 

6 When the uninstallation completes, click [OK]. 

7 Restart the system.
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2.3 Using GAM in a Linux Environment

To use GAM in a Linux environment, it is necessary to install device drivers and 
GAM. 

For using Linux, when setting up the server again from the beginning, install the device drivers and 
GAM, referring to the release notes supplied with the server.
If using Linux on another type of server, visit the PRIMERGY page on the Fujitsu website (http://
primergy.fujitsu.com/) and refer to information about Linux.

When GAM on a Linux server is monitored from GAM Client, GAM Client can only be installed on 
servers or computers running Windows 2003 / Windows 2000 / Windows XP. Make considerations 
when creating system configuration since GAM Client cannot be installed on a server running Linux. 

The following figure shows a system configuration in which GAM Client on a Windows server manages 
a Linux server. 

Rebuild will not start automatically after the replacement from a failed hard disk drive to a new drive. 
You must send a Rebuild command from GAM Client to execute Rebuild after hot swapping of a failed 
hard disk drive. If you do not perform this action, Rebuild will not start and the array will stay as Critical 
status accordingly. 

If there is a firewall in the environment, it is necessary to configure network settings, such as disabling 
blocking of the port used by the GAM protocol. GAM uses TCP port 157 and 158 for transmission. 

Windows server

GAM Client

GAM Server

SCSI array controller

Monitor/configure

GAM status

Notify GAM event

Linux server

http://primergy.fujitsu.com/
http://primergy.fujitsu.com/
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2.4 Using GAM in a Multiple Server 
Environment

The following figure shows a system configuration in which GAM Client on the other 
Windows server manages GAM Server. 

It is necessary to configure the server receiving GAM events during GAM installation. For more details, 
refer to Step 11 in "2.2.1 How to Install GAM" ( pg.17).
If there is a firewall in the environment, it is necessary to configure network settings, such as disabling 
blocking of the port used by the GAM protocol. GAM uses TCP port 157 and 158 for transmission.

2.4.1 Interaction between ServerView and AlarmService

The following figures show the interaction between AlarmService of ServerView and GAM Client on 
the other Windows server manages GAM Server.

■ When Storing OS Event Logs on GAM Client

ServerView must be installed on GAM Client.
The OS event logs related to GAM events are stored on GAM Client. 

GAM Client

GAM Server

Windows server

Monitor/configure

GAM status

Windows server/Linux server

Notify GAM event

SCSI array controller

GAM Client

GAM Server

SNMP ServiceServerView

AlarmService

OS event log

Windows server

Monitor/configure

GAM status

Windows server/Linux server

SCSI array controller

Notify GAM event

 (SNMP Trap)
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■ When Storing OS Event Logs on GAM Server

ServerView must be installed on GAM Server. 
The OS event logs related to GAM events are stored on GAM Server. 

GAM Client
GAM Server

SNMP Service

ServerView
AlarmService

Windows server
Monitor/configure
GAM status

Windows server/Linux server

Notify GAM event
 (SNMP Trap)

OS event log

SCSI array controller
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How to Use GAM
GAM is a basic utility to manage the disk array. 
Read this chapter carefully before use. 

3.1 Overview of GAM  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
3.2 Starting and Exiting GAM . . . . . . . . . . . . . . . . . . . . . . . . . 29
3.3 Window Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
3.4 Server Group and Server Settings . . . . . . . . . . . . . . . . . . 37
3.5 Viewing Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
3.6 Maintenance Functions . . . . . . . . . . . . . . . . . . . . . . . . . . 47



28

Chapter 3　How to Use GAM

3.1 Overview of GAM

GAM is used for monitoring, management, maintenance and configuration of the 
array controller, as well as hard disks and logical drives connected to it. 

3.1.1 About the access privileges to GAM

It is necessary to log on (sign on) to GAM to use GAM functions: user authentication is made using the 
user accounts registered in the OS. Note that available functions vary depending on the user account 
used to log on (sign on). There are three access privileges as shown below:

● Guest

When using GAM with Guest privileges, it is not necessary to log on (sign on). With Guest privileges, 
only the RAID status and occurring events can be checked. It is not possible to set or change parameters.

● User

This is mainly used to monitor the status of controllers and hard disks/logical drives. To use User 
privileges, log on (sign on) with any of the user names and passwords registered in the OS. With User 
privileges, in addition to using the functions made available with Guest privileges, several parameters 
can be changed. It is also possible to view the detailed status of the controller and RAID subsystem 
selected. Note that it is not possible to perform management such as changing a RAID configuration, 
rebuilding drives, and changing parameters related to controllers and drivers. 

RAID cannot be configured and data cannot be destroyed with User privileges. If GAM is used only for 
purposes such as monitoring the RAID system or checking the status, it is recommended that using 
User privileges. 

● Administrator

This is used for management, maintenance and configuration of controllers and hard disks/logical 
drives. To use Administrator privileges, log on (sign on) with "gamroot". In addition to the monitoring 
functions made available with Guest or User privileges, it is possible to use all other functions including 
rebuilding drives and changing the drive status. 

When using GAM with Administrator privileges, depending on the operation, you may lose data in the 
SCSI array controller. Read this chapter and utilize GAM very carefully. 
If GAM information cannot be monitored from ServerView, there is a possibility that the network 
settings are not proper. In this case, check the network settings again. 
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3.2 Starting and Exiting GAM 

This section explains how to start and exit GAM. 

3.2.1 Starting

To start GAM, click [Start] → [Programs] (or [All Programs] on Windows Server 2003)  and [Mylex 
Global Array Manager Client] in this order. 
If a server group or server is already defined, [Global Status View] appears. 

This is the case when using Guest privileges. To use User or Administrator privileges, it is necessary to 
sign on. 
If GAM is started for the first time after its installation, the [Define Server Groups] window appears. 
Refer to "3.4 Server Group and Server Settings" ( pg.37) to make the settings.

3.2.2 Log On (Sign On) 

In GAM, user authentication is performed to limit availability of functions according to uses. It is 
necessary to sign on to GAM to obtain access privileges User or higher. When double-clicking the server 
icon in the [Global Status View] window, or when performing operations requiring Administrator 
privileges, the following [Sign On] window is automatically displayed. 

It is also possible to open the [Sign On] window by selecting [Sign On] from the [Administration] menu. 
If GAM Client and GAM Server are installed on different servers (for the Linux system, etc.), enter the 
password configured on GAM Server. 
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■ Procedure to sign on
Perform the following procedure to sign on.

1 Enter a user name. 
• When signing on with User privileges 

Enter any user name in [Username]. 
• When signing on with Administrator privileges 

Enter "gamroot" in [Username]. 

2 Enter a password in [Password]. 
If [Remember password for this session] is checked, uncheck it. 

Note that if this option is checked, you will automatically sign on to different servers. To avoid
accessing servers automatically, it is recommended to keep this option unchecked. 

3 Click [Sign-on]. 

If Windows is used as a domain controller, it is necessary to set the local logon rights to the
user account used to sign on to GAM. If the local logon rights are not set, it is not possible to
sign on to GAM. Refer to "Chapter 2 Installing Global Array Manager (GAM)" ( pg.15).
In GAM, availability of functions is limited according to access privileges. For access privileges,
refer to "3.1.1 About the access privileges to GAM" ( pg.28).

3.2.3 Exiting

To exit GAM, click [Exit] from [File] in the GAM menu bar.
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3.3 Window Layout

The following provides a description of windows, buttons, and menu items displayed 
when using GAM. 

3.3.1 Startup Window Layout/Functions 

When GAM is started, a window consisting of [Global Status View] and [Log Information Viewer] will 
appear.

■ Menu Bar
Allows you to perform GAM functions. 

■ Tool Bar
Collection of buttons for frequently used functions on GAM. 

■ Server Selection Box 

Clicking ▼ displays a box listing the names of the server groups connected to the current client 
workstation.

■ Global Status View
Displays servers in the currently selected server group. 
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■ Controller Selection Box 

Clicking ▼ displays the onboard SCSI array controller that connects to the currently selected server, or 
the controller ID and type (e.g. MegaRAID SCSI 320-2E) of the SCSI array card.

■ Server Icon
Displays the server status. The following information is available: 
• IP address (e.g. 10.1.19.100) or server name (e.g. ide40) 
• Operating system running on the server (e.g. W2K3=Windows Server 2003, W2K=Windows 2000 

Server) 
• Server status (Green=normal, Yellow=critical, Red=failure or malfunction) 
• Number and status of SCSI array controllers connected to the server (Green=normal, Yellow=critical, 

Red=failure or malfunction) 

■ Log Information Viewer
Displays an event that occurred. 

table: Log Information Viewer
Event Details

Event ID Displays the level of an event to be reported using an icon that signifies information, caution, 
warning, or others. Displays simultaneously the ID assigned to the event being reported. 

Severity Priority level of the event. 

Source IP address or name of the server that sent the event. 

Source Time Time when the event occurred. 

Device Address Other data regarding the channels linked, operations in question, and reason why this event 
was sent. 

Description Description of the event. 

Sequence(Seq) Sequence number of the event. 

Local Time Time when the event occurrence was signaled to GAM Client. 
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3.3.2 [Controller View] Window Layout/Functions

Displaying the [Controller View] window enables you to monitor the status of hard disks/logical drives. 
To display the [Controller View] window, select [Controller View] from the [View] menu. If the [Sign 
On] window opens, sign on according to "3.2.2 Log On (Sign On)" ( pg.29).
The following window appears.

The [Controller View] window displays information shown below regarding the controller currently 
selected in the [Controller Selection] box. 

● Number of controller channels

Each channel is displayed as the tower on the left. 

● Hard disk

Displays the target ID, device capacity, device type and device status. The following shows the hard disk 
status:

table: Hard disk status icon
Icon Color Status

Green Normal (OnLine)

Red Failure (Dead)

Yellow Rebuild in progress (Rebuilding)

Yellow Failure expected (Critical)
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● Logical drive

Displays the logical drive number and capacity, RAID level set, and logical drive status. The following 
shows the logical drive status: 

● Enclosure

This function is not supported. 

Double-clicking the icon of each hard disk/logical drive enables you to see more detailed information. 
For more details, refer to "3.5 Viewing Information" ( pg.38).

3.3.3 Menu Layout/Functions 

The following explains the function of each menu item. 

■ [File] Menu

■ [View] Menu

table: Logical drive status icon
Icon Color Status

Green Normal (OnLine)

Yellow Operating without redundancy (Critical)

table: [File] Menu
Menu Function

Clear Configuration Clears all the RAID configurations of the currently selected SCSI array controller.
This onboard SCSI array controller does not support this function.

table: [View] Menu
Menu Function

Global Status View Displays the [Global Status View] window. By default, [Global Status View] is configured 
to open at the time of GAM startup. 

Controller View Displays the [Controller View] window. This window displays information of each device, 
or displays the status of hard disks or logical drives connected to the controller selected in 
the controller selection box. 

Log Information 
Viewer

Displays the [Log Information Viewer] window. This window displays events or errors 
that occurred in the SCSI array controller. [Log Information Viewer] opens automatically 
when GAM Client starts up. 

Rebuild Status Displays progress of the on-going rebuild. This is selectable only while a rebuild is in 
progress. 

Error Table Displays the sense data. A list of sense data on the hard disks connected to the selected 
SCSI array controller will be displayed.
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■ [Administration] Menu 

table: [Administration] Menu 
Menu Function

Sign On Allows you to log on when using GAM's monitoring and setting functions. If signing on 
with a user account registered on the server, it is possible to use the monitoring function 
(available with User privileges). Signing on with "gamroot" enables you to use the GAM's 
setting and management functions (available with Administrator privileges). 

Define Server 
Groups

Sets a server group and the name or IP address of each server in the group. 

Select Current 
Server Group

Selects a server group. Functions here are the same as those of the [Server Selection] box. 
Note: 

Make sure to select a server group that was registered using [Define Server 
Group]. 

Select Current 
Controller

Selects a controller to be managed. Functions here are the same as those of the [Controller 
Selection] box. 

Controller 
Information

Displays major information of the currently selected SCSI array controller. 

Enclosure 
Information

Displays the information of SES and SAF-TE Enclosure Management. 
Note: 

The Enclosure Information function is not supported. Hard disk cabinets cannot 
be monitored using this function. 

Scan Devices Redetects the hard disks connected. 

Settings Not supported. Do not use this function. 
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3.3.4 Tool Bar Icons

Tool bar icons at the top of the [Global Array Manager] window enable you to start up frequently used 
functions. 

table: Tool Bar Icons 
Icon Function

Rescans the devices.  

Displays controller information.  

Displays sense data. 

Displays the [Sign On] window.  

This function is not supported. 

Displays Help. 
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3.4 Server Group and Server Settings 

The server group setting window automatically displays when GAM Client is started 
for the first time. Perform the following procedure to add a server group and servers. 
It is also possible to set a server group by selecting [Define Server Groups] from the 
[Administration] menu. 

1 Click [Add] in the [Server Groups] area. 
The [Adding Item] window appears.

2 Enter any name for the server group to be added using the [Adding Item] 
window. 

3 Click [OK].
The added server group name is displayed in the [Server Groups] area. 

4 Select the server group added and click [Add] in the [Servers] area. 
The [Adding Item] window appears.

5 Enter the computer name of the server you want to monitor using the [Adding 
Item] window. 

6 Click [OK].
The entered server name will be added in the [Server] area. 

7 Click [OK] to close the [Define Server Groups] window. 
Check that the registered server appears in [Global Status View]. 
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3.5 Viewing Information 

The following information can be viewed using GAM. 

• Information of an event or error that occurred: Refer to "A List of GAM Error Codes" ( pg.56)
• Array configuration or controller information: Refer to "3.5.2 RAID Controller" ( pg.40)
• Hard disk information: Refer to "3.5.3 Displaying Hard Disk Information" ( pg.42)
• Logical drive information: Refer to "3.5.4 Displaying Logical Drive Information" ( pg.44)
• Request Sense Data information: Refer to "3.5.5 Displaying Request Sense Data" ( pg.45)
• Information of Rebuild progress: Refer to "3.5.6 Checking the Progress of a Rebuild" ( pg.46)

3.5.1 Event

GAM monitors the behaviors of all hard disks and controllers connected to the server. If a behavior that 
should be treated as an event (a serious event such as hard disk failure or an event related to spare disk 
allocation) is found, that event is noticed to GAM.
Events such as errors, information, or management tasks in the RAID system are displayed in [Log 
Information Viewer]. 

To write the incidence of an event or error into event logs of the operating system, it is necessary to 
install ServerView. Refer to "User's Guide" in the PRIMERGY Document & Tool CD provided with the 
server to install and configure ServerView. 
The GAM Server records detailed information on occurred events in the file "GAMEVLOG.LOG". This 
file may be used when investigation is necessary.
The path where "GAMEVLOG.LOG" is stored is as follows, depending on the OS. The path may differ 
depending on the installation environment.
• Windows Server 2003 / Windows 2000 Server:

[C:\WINDOWS\System32\GAMSERV\gamelog.log]
• Windows Server 2003 x64:

[C:\WINDOWS\SysWOW64\GAMSERV\gamevlog.log]
• Linux:

[/var/log/gamevlog.log]
While GAM Client is running, if the IP address of the server to be monitored is changed or the LAN 
connection is disconnected, the "Lost connection to server, or server is down" message will be 
recorded every 10 minutes. 
If the IP address or computer name of Client is changed after GAM Server was installed, events 
cannot be noticed correctly. In this case, it is necessary to uninstall GAM Server first and then install it 
again. (If the IP address is automatically obtained from the DHCP server, the IP address may be 
changed depending on the timing of powering on/off or restarting the system.) 
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■ Log Information Viewer 
[Log Information Viewer] opens automatically when a SCSI array controller is detected at the time of 
GAM Client startup. 

Event histories displayed in [Log Information Viewer] are stored in the GAM2CL.LOG file. 

To open [Log Information Viewer] manually, select [Log Information Viewer] from the [View] menu. 
For the meaning of each item displayed in [Log Information Viewer], refer to "3.3.1 Startup Window 
Layout/Functions" ( pg.31).

■ Displaying Detailed Information of Each Event 
When detailed information of an event displayed in [Log Information Viewer] is needed, display the 
[Event ID] window. 
Double-click the event displayed in [Log Information Viewer] to display the [Event ID] window.

Detailed information on the selected event is displayed. 
Click [OK] to close the [Event ID] window. 



40

Chapter 3　How to Use GAM

3.5.2 RAID Controller

The [Controller View] window enables you to view the status of the RAID controller and hard disks or 
logical drives connected. 

■ Starting Controller View
Double-click the server icon in [Global Status View] to start [Controller View]. If you have not signed 
on to the server, the [Sign On] window appears. Sign on to the server using this window. 

For details on icons in the [Controller View] window, refer to "3.3.2 [Controller View] Window Layout/
Functions" ( pg.33).
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■ Displaying RAID Controller Detailed Information
Click [Controller Information] from the [Administration] menu ("[Administration] Menu" pg.35). 
The [Controller Information] window appears. You can set controller options by clicking [Controller 
Options]. 

Click [Close] to close the [Controller Information] window. 

Displayed Bus#, Dev#, and IRQ are not supported. These displayed values may differ from their actual 
values. To find out the correct bus number, device number and IRQ, check them using Device 
Manager, etc. 
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3.5.3 Displaying Hard Disk Information

The [Controller View] window displays details of hard disks connected to channels of the controller. 
Each drive column indicates the hard disks connected to one controller channel each. 
Double-clicking a hard disk icon enables you to see the information of a specific hard disk.

Channel and target ID of the hard disk are displayed in the title bar. 

● Displayed information

The following information is displayed.
• Vendor

Hard disk vendor.
• Product

Hard disk model name. 
• Revision

Version of firmware on the hard disk.
• Bus Width

SCSI bus width.
• ANSI Version

ANSI version supported.
• Serial

Disk drive's serial number.



43

Onboard SCSI RAID User’s Guide

3

H
ow

 to U
se G

AM

• Nego. Transfer Speed / Nego. Bus Width
Current transfer speed (MB/second) and current transfer bus width. 

The transfer speed may become slower if an error temporarily occurs in the hard disk. Nor-
mally, if the status of the hard disk is not dead, this phenomenon does not pose any problem to 
operation. However, if the performance is very low, restart the system to reconfugure the trans-
fer speed. 

• Physical Capacity
Physical capacity of the hard disk.

• Sector Size
Sector size.

• Config. Size
Available hard disk capacity when connected. 

• Status
Current status of the hard disk. 
The hard disk status is as follows: 

• Device Errors
The kind of the error is displayed. In this server, only PFA Count (failure prediction) is supported.
If PFA Count is found, refer to "4.3 Preventive Replacement Procedure of a Hard Disk" ( pg.52) to 
replace the hard disk.

● Function buttons

The following operations can be performed using buttons. 
• Make Offline button

Forcibly changes the status of a hard disk to "Dead". 

Perform the rebuild operation especially when changing hard disks status from the "Offline" to 
the "Online". Data may be lost by performing [Make Offline] operation.

• Locate button
Blinks the access lamp on the hard disk and notifies the hard disk position. 

table: The status of the hard disk
Status Meaning

OnLine Online (normal)

Dead Dead (failed)

Dead (absent) Dead (Drive is not found)

Rebuilding Rebuild in progress 

Critical State of failure being expected (PFA Count)
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3.5.4 Displaying Logical Drive Information 

Defined logical drives are displayed at the right of the [Controller View] window, each icon representing 
one logical drive (also called Logical Unit or System Drive).
To display information of a specific logical drive, double-click a logical drive icon in the [Controller 
View] window. 

Logical drive number are displayed in the title bar. 

● Displayed information

The following information is displayed.
• RAID Level / Fault Tolerant

RAID level and applicability of redundancy. 
• Optimized for Speed / Optimized for Capacity

Whether the speed set, capacity, or redundancy is optimized. 
• Logical Size / Physical Size

Logical and physical sizes of the logical drive. 
• Stripe Size

Stripe size the logical drive uses. 
• Write Cache

Write back cache setting. 
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• Status
Current logical drive's operation status. 
The meaning of each status is as follows:

• Used Array Capacity
Of the physical pack capacity, the capacity occupied by the current logical drive.

● Function buttons

The following operations can be performed using buttons. 
• Locate button

Blinks the access lamps on all the hard disks that compose the logical drive and notifies the hard disk 
positions. 

• Rebuild button
When logical drive status is "Critical",  [Rebuild] button is enabled, and you can rebuild of logical 
drive. Refer to "3.6.1 Rebuild" ( pg.47).

3.5.5 Displaying Request Sense Data 

To display hard disk sense information, select [Error Table] from the [View] menu. 
The following window appears. 

It is possible to save sense information to a file by clicking [Save File]. 

Request Sense Data is data used for problem investigation. 
When the system is restarted, Request Sense Data is cleared. 

table: Logical drive's operation status.
Status Meaning

OnLine Online (normal) 

Critical Operating without redundancy 
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3.5.6 Checking the Progress of a Rebuild

Using GAM, you can check the progress of a rebuild in graph from.

■ Rebuild Status

When a rebuild is in progress, it is possible to check its progress by selecting [Rebuild Status] from the 
[View] menu. 

Click [Close] to close the [Rebuild Status] window. 
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3.6 Maintenance Functions

Rebuild can be executed for a logical drive that status is "Critical". 

3.6.1 Rebuild

If a failed hard disk is replaced, it is necessary to execute a rebuild. To execute a rebuild, perform the 
following procedure.

For hard disk replacement and rebuild operations, follow the procedure in "Chapter 4 Replacing a Hard 
Disk" ( pg.49).

1 Double-click the Critical logical drive (  ) in the [Controller View] window. 
The [Logical Drive Information] window appears.

2 Click [Rebuild].
The [Rebuild Status] window appears and a rebuild starts. 
Click [OK] if the following window appears after completion of rebuild operation. The window 
may not appear depending on the environment.

The hard disk becomes online and the logical drives are restored to a state of redundancy 
(online). 

3 Click [OK].
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Chapter 4

Replacing a Hard Disk

This chapter explains maintenance related 
issues, such as hard disk replacement.

4.1 Confirming the Hard Disk . . . . . . . . . . . . . . . . . . . . . . . . . 50
4.2 Replacing a Hard Disk . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
4.3 Preventive Replacement Procedure of a Hard Disk  . . . . . 52
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4.1 Confirming the Hard Disk

Before replacing the hard disk, check the channel and ID of the failed hard disk.

1 Start and log on to the GAM.
Refer to "3.2 Starting and Exiting GAM" ( pg.29).

2 Select [Controller View] from the [View] menu.
The Controller View window ( pg.33) appears.

3 Check the hard disk status icon.
When the hard disk has failure, the [Failure] status icon is displayed.
When a failure prediction is issued, the [Critical] status icon is displayed.
For information on the icon, refer to "●  Hard disk" ( pg.33).

If any hard disk is being rebuilt, wait until the process completes. After its completion, check
the hard disk.

4 Double-click the hard disk icon to check the details.
When a failure prediction(S.M.A.R.T.) is issued, [PFA Count] in the [Device Errors] field is 
displayed as [Found].

5 When exists of failure or failure predicted hard disk, replace the hard disk as 
follows:

When failure hard disk exists.
Replace the hard disk, referring to "4.2 Replacing a Hard Disk" ( pg.51).

When failure predicted hard disk exists.
Replace the hard disk, referring to "4.3 Preventive Replacement Procedure of a Hard Disk" 
( pg.52).

If one hard disk has a failure, the other has a failure prediction
Replace the failed hard disk first, and perform the rebuild process. Confirm the hard disk again
after its completion. If a failure prediction hard disk is still displayed, execute preventive
replacement of hard disk.
If failure prediction hard disk was replaced before replacing the failed one, rebuild cannot be
performed and redundancy is not functioned. Also, data may be lost.
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4.2 Replacing a Hard Disk

If a hard disk fails, it must be replaced with a new hard disk as soon as possible. 
Replace a failed hard disk without turning off the server. 

For replacement, use a hard disk of the same model (with the same capacity and speed) as the failed 
hard disk as a rule. 

1 Check the channel and ID of the failed hard disk using GAM.
Refer to "4.1 Confirming the Hard Disk" ( pg.50)

2 Check the hard disk failure LED corresponding to the failed hard disk is lit. 

3 Pull out the plastic lever 90 degrees towards you, and also pull out the failed 
hard disk unit 1 to 3cm to disconnect it from the SCSI bus.

Do not pull out the hard disk unit completely from the server.

4 Wait 1 minute or more until the rotation of the motor in the hard disk unit stops.

5 Pull out the failed hard disk from the hard disk bay.

6 Install a new hard disk in the hard disk bay where the failed hard disk was 
previously installed.

7 Double-click the Critical logical drive (  ) in the [Controller View] window of 
GAM. 
The [Logical Drive Information] window appears.

8 Click [Rebuild]. 
Rebuild starts. When rebuilding is started, the Hard disk failure LED of the replaced hard disk 
that was lit starts to blink, and turns off after rebuilding is completed. 
After its completion, make sure that the status of the logical drive has changed from "Critical" to 
"OnLine" using [Logical Drive Information] of GAM.

If restart or shutdown is executed during the rebuild, rebuild resumes at the next launch start-
ing from the position where the process stopped.
The rebuild may not start even if [Rebuild] is clicked. In this case, perform [Scan Device] that
can be selected from the [Administration] menu, and perform the rebuild process again.
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4.3 Preventive Replacement Procedure 
of a Hard Disk

When the failure prediction function of the hard disk reports the [Critical] status of a 
hard disk, it may fail at a future date. If the Critical status is reported, perform 
preventive replacement of the hard disk.
Replace a failed hard disk without turning off the server.

For preventive replacement, use a hard disk of the same model (with the same capacity and speed) as 
the likely-to-fail disk as a rule. 
It is recommended to back up data before executing preventive replacement of a hard disk.
When both hard disks are expected to fail, perform preventive replacement of one disk at a time.

1 Check the channel and ID of the likely-to-fail hard disk using GAM.
Refer to "4.1 Confirming the Hard Disk" ( pg.50)

2 Confirm that the status of the other hard disk is [OnLine]. 

When the hard disk fails (the status is [Dead]), replace the failed hard disk first, and perform
the rebuild process. Confirm the hard disk again after its completion. If a failure prediction hard
disk is still displayed, execute preventive replacement of hard disk.
If failure prediction hard disk was replaced before replacing the failed one, rebuild cannot be
performed and redundancy is not functioned. Also, data may be lost.

3 Double-click the icon of the likely-to-fail hard disk by [Controller View] window. 
Confirm that the "Status" in [Device State] indicates "Critical".

4 Click [Make Offline]. When the [WARNING] window appears, enter "YES" and 
click [OK].

5 Check the Hard disk failure LED corresponding to the likely-to-fail hard disk is 
lit. 

6 Confirm that the following log is displayed in Log Information Viewer of GAM.

7 Pull out the plastic lever 90 degrees towards you, and also pull out the likely-to-
fail hard disk unit 1 to 3cm to disconnect it from the SCSI bus.

Do not pull out the hard disk unit completely from the server.

8 Wait 1 minute or more until the rotation of the motor in the hard disk unit stops.

Event ID ：S-12
Description ：A physical disk has failed.
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9 Pull out the likely-to-fail hard disk from the hard disk bay.

10 Install a new hard disk in the hard disk bay where the likely-to-fail hard disk was 
previously installed.

11 Start GAM, and double-click the Critical logical drive (  ) in the [Controller 
View] window of GAM. 
The [Logical Drive Information] window appears.

12 Click [Rebuild]. 
Rebuild starts. When rebuilding is started, the Fault LED of the replaced hard disk that was lit 
starts to blink, and turns off after rebuilding is completed. 
After its completion, make sure that the status of the logical drive has changed from "Critical" to 
"OnLine" using [Logical Drive Information] of GAM.

If restart or shutdown is executed during the rebuild, rebuild resumes at the next launch starting from 
the position where the process stopped.
The rebuild may not start even if [Rebuild] is clicked. In this case, perform [Scan Device] that can be selected 
from the [Administration] menu, and perform the rebuild process again.
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This chapter explains the list of GAM error 
codes.

A List of GAM Error Codes . . . . . . . . . . . . . . . . . . . . . . . . . 56
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A List of GAM Error Codes

By installing ServerView, errors that occur can be logged to Event Viewer. The 
following is a list of logs written to the application log of Windows Event Viewer as 
events of the "Fujitsu ServerView Service" source. The device address is logged at 
the beginning of the event log (part within [ ]). The device address indicates where 
the event occurred. 

Unless ServerView is installed, event logging to Event Viewer will not occur. Refer to "User's Guide" in 
the PRIMERGY Document & Tool CD provided with the server to install and configure ServerView. 

The correspondence of Severity in GAM events (SNMP TRAP), Severity in Gam2cl logs, and the event 
log type is shown in the table below.

table: Meaning of event log's character strings
character strings Meaning

clt: Controller ID

chn: Channel

tgt: Target ID of the physical device

logdrv: Logical drive number

table:  The event log types and explanations
Severity Description Severity in Gam2cl.log OS event log type

CRITICAL Severe error 1 Error

MAJOR Error 2 Error

MINOR Warning 3 Warning

INFORMATIONAL Information 
(No action required) 4 Information

ka
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The number within the brackets of the GAM ID is displayed in hexadecimal. 

table: List of event log
GAM ID Severity Description Details Corrective action

1
(0x01)

Info A physical disk has 
been placed online.

The hard disk entered the 
state of online by having 
completed rebuild. 

None.

3
(0x03)

Warning Physical disk error 
found.

• A bad sector was found 
on the media. 

• A mechanical failure of 
the device. The host 
device detected an 
invalid sequence. 

Because the controller is 
implementing a recovery, no 
action is required as long as the 
corresponding disk is Online. 
However, if this occurs 
frequently, it is recommended to 
replace the disk as a 
precautionary measure. 

4
(0x04)

Warning Physical disk PFA 
condition found; 
this disk may fail 
soon.

A failure was predicted for 
the hard disk. 

Refer to "4.3 Preventive 
Replacement Procedure of a Hard 
Disk" ( pg.52).

5
(0x05)

Info An automatic 
rebuild has started.

Rebuild started. None.

6
(0x06)

Info A rebuild has 
started.

Rebuild started via a 
command. 

None.

7
(0x07)

Info Rebuild is over. Rebuild completed 
successfully.

None.

8
(0x08)

Warning Rebuild is 
cancelled.

Rebuild was cancelled. Re-execute the rebuild. 

9
(0x09)

Error Rebuild stopped 
with error.

Rebuild terminated 
abnormally. 

Check the logs surrounding the 
process and perform necessary 
actions. 

10
(0x0a)

Error Rebuild stopped 
with error. New 
device failed.

Rebuild terminated 
abnormally due to a bad 
hard disk for the rebuild. 

Replace the hard disk and 
perform the rebuild process. 

11
(0x0b)

Error Rebuild stopped 
because logical 
drive failed.

The source disk of the 
rebuild failed. 

After backing up the data, replace 
the "Rebuild" source disk unit, 
reconfigure the array, and restart 
the system installation.

12
(0x0c)

Error Physical disk has 
failed.

A hard disk failed. Replace the hard disk of "Dead" 
and perform the rebuild process.

13
(0x0d)

Info A new physical 
disk has been 
found.

A new hard disk was 
detected. This is logged in 
the following situations:
• A hard disk was added.
• The controller was 

powered on. 
• A controller was added.
• The system was 

rebooted. 

None.

14
(0x0e)

Info A physical disk has 
been removed.

A hard disk was removed. None.

15
(0x0f)

Info A previously 
configured disk is 
now available.

A hard disk was removed 
form array configuration.

None.
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19
(0x13)

Warning SCSI command 
timeout on hard 
device.

A command timeout was 
detected. 

Because the firmware is 
implementing a recovery, there is 
no problem as long as there are 
no Dead hard disks. 

20
(0x14)

Error SCSI command 
abort on hard disk.

• The user aborted the 
command.

• The firmware aborted the 
command to recover 
from an error. 

• A device aborted the 
command.

Because the firmware is 
implementing a recovery, there is 
no problem as long as there are 
no Dead hard disks. 

21
(0x15)

Warning SCSI command 
retried on hard 
disk.

• The command timed out. 
• A bus reset occurred. 
• A device reset occurred.

Because the firmware is 
implementing a recovery, there is 
no problem as long as there are 
no Dead hard disks. 

22
(0x16)

Warning Parity error found. A parity error was detected. If one hard disk unit has a failure, 
replace the hard disk and perform 
the rebuild process. If both of the 
two hard disk units fail, replace the  
"Rebuild" source disk unit, 
configure the array, and restart the 
system installation.
If errors still occur frequently, the 
SCSI cable or the SCSI BP must 
be replaced. Contact an office 
listed in the "Contact 
Information" of "Start Guide".

23
(0x17)

Warning Soft error found. An error was detected in a 
hard disk, but it was 
resolved. 

No action is required. 
If this frequently occurs, replace 
the hard disk as a precautionary 
measure. 

24
(0x18)

Warning Misc error found. • A hard disk reported an 
error.

• The Read/Write 
command timed out.

• A hard disk is Busy.

No action is required. 
If this frequently occurs, replace 
the hard disk as a precautionary 
measure. 

25
(0x19)

Info SCSI device reset. The firmware issued a reset 
for recovery.

No action is required. 
If this frequently occurs, check 
the logs surrounding the process 
and perform necessary actions. 

28
(0x1c)

Error Request Sense 
Data available.

A hard disk reported sense 
information. 

Because the controller is 
implementing a recovery, no 
action is required as long as the 
corresponding disk is Online. 
For GAM Client, displayed 
message is replaced with sense 
information.

33 to 39
(0x21) 
to
(0x27)

Error A physical disk 
failed because...

A hard disk failed. Replace the hard disk and 
perform the rebuild process. 

table: List of event log
GAM ID Severity Description Details Corrective action
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40
(0x28)

Error A physical disk 
failed because of 
the system reset.

A SCSI bus error or hard 
disk failure occured.

When the hard disk is failed, 
replace the hard disk. When the 
hard disk is not failed but errors 
still occur frequently, replace the 
SCSI cable or the SCSI  BP.
When only this error is logged 
and no other hard disk errors 
occur, the noise recovery process 
will recover the error and no 
action is required.

41
(0x29)

Error A physical disk 
failed because of 
busy status or 
parity error.

A hard disk failed. Replace the hard disk and 
perform the rebuild process.

42
(0x2a)

Error A physical disk set 
to failed state by 
host.

Make Offline was executed. Replace the hard disk and 
perform the rebuild process.

43 to 49
(0x2b)
to
(0x31)

Error A physical disk 
failed because...

A hard disk failed. Replace the hard disk and 
perform the rebuild process.

50
(0x32)

Error Physical device 
status changed to 
offline.

The status of the hard disk 
became "Dead". 

When the hard disk is failed, 
replace the hard disk and perform 
the rebuild process.

52
(0x34)

Error Physical device 
status changed to 
rebuild.

The status of the hard disk 
became "Rebuilding". 

None.

53
(0x35)

Error Physical device ID 
did not match.

Hard disk ID is not 
matched. 

None.

54
(0x36)

Error Physical device 
failed to start.

The hard disk failed to start. When the hard disk is failed, 
replace the hard disk and perform 
the rebuild process.

57
(0x39)

Error Physical drive 
missing on startup.

No hard disk was detected 
during startup.

Replace the hard disk and 
perform the rebuild process.

58
(0x3a)

Warning Rebuild startup 
failed due to lower 
disk capacity.

Insufficient hard disk space 
to perform the rebuild. 

Replace the hard disk with a disk 
of the same model (with the same 
capacity and speed) as the other 
disks, and perform the rebuild 
process.

68
(0x44)

Info Physical disk type 
is not approved by 
vendor.

The not supported hard disk 
is installed. 

When you confirm that the 
installed hard disk unit is the 
proper model and the error still 
occurs,  the baseboard must be 
replaced. Contact an office listed 
in the "Contact Information" of 
"Start Guide".

71
(0x47)

Error Mirror Race 
recovery failed for 
logical drive.

It has failed in the writing 
processing of light buffer. 

When the hard disk is failed, 
replace the hard disk.
If the message still appears after 
the replacement, the baseboard 
must be replaced. Contact an 
office listed in the "Contact 
Information" of "Start Guide".

table: List of event log
GAM ID Severity Description Details Corrective action
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72
(0x48)

Error Controller 
parameters 
checksum 
verification failed -- 
restored default.

The mistake was found in 
the checksum of the 
controller parameters.

Check and correct the 
configuration using the SCSI 
Setup Utility.

73
(0x49)

Info Online controller 
firmware upgrade 
has started.

Online controller firmware 
upgrade has started.

None.

74
(0x4a)

Info Online firmware 
upgrade has 
completed 
successfully.

Online firmware upgrade 
has completed successfully.

None.

75
(0x51)

Warning Online firmware 
upgrade has failed.

Online firmware upgrade 
has failed.

Re-execute online controller 
firmware upgrade.
If the error still occurs, the 
baseboard must be replaced. 
Contact an office listed in the 
"Contact Information" of "Start 
Guide".

80
(0x4b)

Warning Firmware entered 
unexpected state at 
run-time.

Firmware entered 
unexpected state at run-
time.

The firmware may have crashed.  
The baseboard must be replaced. 
Contact an office listed in the 
"Contact Information" of "Start 
Guide".

81
(0x50)

Info Rebuild stopped on 
controller failure.

Rebuild stopped due to 
controller's abnormality. 

The baseboard must be replaced. 
Contact an office listed in the 
"Contact Information" of "Start 
Guide".
Perform the rebuild process after 
replaced the baseboard.  

86
(0x56)

Info Rebuild resumed. Rebuild restarted. None.

89
(0x59)

Info Physical disk 
transfer speed 
changed.

The transfer speed of the 
hard disk changed. 

Check the status of the array and 
implement necessary steps. 

126
(0x7e)

- Firmware corrected 
the ‘Read’ error.

The media error was 
corrected. 

None.

135
(0x87)

Error Logical drive is 
critical.

Due to one of the hard disks 
failing, the logical drive is 
now in Critical state. 

Replace failed hard disk and 
perform the rebuild process.

136
(0x88)

Info Logical drive has 
been placed online.

• Rebuild completed. 
• The user executed Make 

Online. 
• A new configuration was 

added. 

None.

137
(0x89)

Info An automatic 
rebuild has started 
on logical drive.

Rebuild started. None.

138
(0x8a)

Info A manual rebuild 
has started on 
logical drive.

Rebuild started. None.

table: List of event log
GAM ID Severity Description Details Corrective action
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139
(0x8b)

Info Rebuild on logical 
drive is over.

Rebuild completed. None.

140
(0x8c)

Warning Rebuild on logical 
drive is cancelled.

Rebuild was cancelled. Re-execute the rebuild.

141
(0x8d)

Error Rebuild stopped 
with error.

Rebuild terminated 
abnormally.

Check the logs surrounding the 
process and perform necessary 
actions.

142
(0x8e)

Error Rebuild stopped 
with error. New 
device failed.

Rebuild terminated 
abnormally due to a bad 
hard disk for the rebuild.

Replace the hard disk and 
perform the rebuild process.

143
(0x8f)

Error Rebuild stopped 
because logical 
drive failed.

The source disk of the 
rebuild failed.

After backing up the data, replace 
the "Rebuild" source disk unit, 
reconfigure the array, and restart 
the system installation.

144
(0x90)

Info Logical drive 
initialization 
started.

The initialization of a 
logical drive started.

None.

145
(0x91)

Info Logical drive 
initialization done.

The initialization of the 
logical drive completed. 

None.

146
(0x92)

Warning Logical drive 
initialization 
cancelled.

The initialization of the 
logical drive was cancelled. 

Re-execute the initialization 
process. 

147
(0x93)

Error Logical drive 
initialization failed.

The initialization terminated 
abnormally. 

Replace the hard disk and 
perform the rebuild process. 

148
(0x94)

Info A logical drive has 
been found.

A logical drive was newly 
detected by restarting the 
system. 

None.

149
(0x95)

Info A logical drive has 
been deleted.

A logical drive was deleted. None.

153
(0x99)

Error Bad Blocks found. A bad block was detected 
during the rebuild process. 

If a corrupted file is found, 
restore it from the backup.

156
(0x9c)

Error Bad data blocks 
found. Possible 
data loss.

Bad blocks were found in 
multiple hard disks in the 
same location. 

If a corrupted file is found, 
restore it from the backup. 

157
(0x9d)

Warning Logical drive LUN 
mapping has been 
written to config.

Logical drive LUN mapping 
has been written to config.

None.

158
(0x9e)

Error Attempt to read 
data from block 
that is marked in 
Bad Data Table.

Attempted to read data 
logged in the BDT table. 

If a corrupted file is found, 
restore it from the backup. 

159
(0x9f)

Error Data for Disk 
Block has been lost 
due to Logical 
Drive problem.

Due to a problem with the 
logical drive, cache data 
could not be written to the 
hard disk. 

Check the logs surrounding the 
process and perform necessary 
actions. 

384
(0x180)

Info Array management 
server software 
started 
successfully.

GAM Server started 
successfully. 

None.

table: List of event log
GAM ID Severity Description Details Corrective action
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386
(0x182)

Warning Internal log 
structures getting 
full, PLEASE 
SHUTDOWN 
AND RESET THE 
SYSTEM IN THE 
NEAR FUTURE.

Due to many configuration 
changes, the configuration 
change table is full.

Shut down the system properly, 
power off the server and turn it 
back on.
If the error still occurs, the 
baseboard must be replaced. 
Contact an office listed in the 
"Contact Information" of "Start 
Guide".

388
(0x184)

Error Controller is dead. 
System is 
disconnecting from 
this controller.

The SCSI array controller 
failed. 

The baseboard must be replaced. 
Contact an office listed in the 
"Contact Information" of "Start 
Guide".

389
(0x185)

Warning Controller has been 
reset.

The SCSI array controller 
received a reset command. 

Because the firmware is 
implementing a recovery, there is 
no problem as long as there are 
no Dead hard disks.

390
(0x186)

Info Controller is 
found.

• A new SCSI array 
controller was detected. 

• GAM Server restarted. 
• The system was 

rebooted.

None.

391
(0x187)

Error Controller is gone. 
System is 
disconnecting from 
this controller.

The response from the SCSI 
array controller was lost. 

The baseboard must be replaced. 
Contact an office listed in the 
"Contact Information" of "Start 
Guide".

395
(0x18b)

396
(0x18c)

Info Controller powered 
on.

A SCSI array controller was 
powered on.

None.

397
(0x18d)

Info Controller is 
online.

A SCSI array controller 
came online.

None.

398
(0x18e)

Error Controller is gone. 
System is 
disconnecting from 
this controller.

The response from the SCSI 
array controller was lost. 

The baseboard must be replaced. 
Contact an office listed in the 
"Contact Information" of "Start 
Guide".

403
(0x193)

Error Installation 
aborted.

The configuration changed 
while the system was 
offline. 

Shut down the server and check 
the hard disk connections. 
Check to see whether the 
appropriate hard disks are 
installed, and remove 
inappropriate hard disks. 
(For example, a hard disk for 
another system was installed by 
accident.) 
If the above does not resolve the 
issue, reconfigure the array and 
restore the backup data.

404
(0x194)

Error Controller 
firmware 
mismatch.

SCSI array controller 
firmware mismatch.

The baseboard must be replaced. 
Contact an office listed in the 
"Contact Information" of "Start 
Guide".

406
(0x196)

Error WARM BOOT 
failed.

It failed in WARM Boot. Check the log and identify the 
malfunction.

table: List of event log
GAM ID Severity Description Details Corrective action
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411
(0x19B)

Warning Controller entered 
Conservative 
Cache Mode.

SCSI array controller 
entered Conservative Cache 
Mode.

None.

412
(0x19c)

Warning Controller entered 
Normal Cache 
Mode.

SCSI array controller 
entered Normal Cache 
Mode.

None.

413
(0x19d)

Warning Controller Device 
Start Complete.

The controller device 
started. 

None.

425
(0x1a9)

Error Controller Boot 
ROM Image needs 
to be reloaded.

Controller Boot ROM 
Image needs to be reloaded.

The baseboard must be replaced. 
Contact an office listed in the 
"Contact Information" of "Start 
Guide".

426
(0x1aa)

Error Controller is using 
default non-unique 
world-wide name.

SCSI array controller is 
using default non-unique 
world-wide name.

None.

427
(0x1ab)

Error Mirror Race 
recovery failed.

Multiple hard disks failed. Replace failed hard disk, 
reconfigure the array, and restart 
the system installation.

428
(0x1ac)

Error Mirror Race on 
critical drive.

The logical drive went 
critical.

Replace the hard disk and 
perform the rebuild process. 

512
(0x200)

Info System started.- The server or GAM Server 
started. 

None.

514
(0x202)

Info User logged in.- The user logged in to the 
server. 

None.

515
(0x203)

Info User logged out.- The user logged out of the 
server. 

None.

516
(0x204)

Info Server alive. • Reconnected to the 
server. 

• The server rebooted.

None.

517
(0x205)

Error Lost connection to 
server, or server is 
down.

• The network connection 
to the server was lost. 

• The server shut down. 

Check the network. 
Check that the server is running.

518
(0x206)

Info Automatic reboot 
count has changed.

Automatic reboot count has 
changed.

None.

640
(0x280)

Warning Channel Failed. The channel failed. Replace the SCSI BP, SCSI cable 
or base board. 
Contact an office listed in the 
"Contact Information" of "Start 
Guide".

641
(0x281)

Warning Channel Online. The channel was restored. None.

700
(0x2bc)

Warning Event Log Empty. The content of Event Log 
became blank. 

None.

701
(0x2bd)

Warning Event Log Entries 
Lost.

Event Log Entries were lost. None.

800
(0x320)

Warning New Configuration 
Received.

A new configuration was 
set. 

None.

table: List of event log
GAM ID Severity Description Details Corrective action
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801
(0x321)

Warning Configuration 
Cleared.

The array configuration was 
cleared. 

None.

802
(0x322)

Warning Configuration 
Invalid.

The array configuration 
information is invalid. 

Check to see whether the hard 
disk is connected properly. 
If the above does not resolve the 
issue, reconfigure the array and 
recover the backup data.

803
(0x323)

Warning Configuration On 
Disk Access Error.

The array configuration 
information could not be 
read from the hard disk. 

Recreate the array and recover 
the backup data. 

805
(0x325)

Warning Configuration On 
Disk Import 
Failed.

The array configuration 
information could not be 
imported. 

Check to see whether the hard 
disk is connected properly. 
If the above does not resolve the 
issue, reconfigure the array and 
recover the backup data.

806
(0x326)

Info A Debug Dump 
exists on this 
system.

A Debug Dump exists on 
this system.

None.

807
(0x327)

Info A Debug Dump 
exists on this 
system.

808
(0x328)

Info No valid 
Configuration On 
Disk (COD) found.

No valid Configuration On 
Disk (COD) found.

Turn off the server and check 
whether the hard disk unit is 
connected correctly.
If the error still occurs, 
reconfigure the array and restore 
the data.

896
(0x380)

Error Internal Controller 
is in the hung state.

The SCSI array controller 
hung. 

The baseboard must be replaced. 
Contact an office listed in the 
"Contact Information" of "Start 
Guide".

928
(0x3a0)

Error Internal Controller 
has encountered 
Strong-ARM 
processor specific 
error.

An error in the SCSI array 
controller was detected. 

The baseboard must be replaced. 
Contact an office listed in the 
"Contact Information" of "Start 
Guide". 

944
(0x3b0)

Error Internal Controller 
Backend Hardware 
Error.

-1 Error Unknown Error. An unknown error was 
detected.

Check the logs surrounding the 
process and perform necessary 
actions. 
Unless the hard disk is dead, no 
action is required, because the 
firmware is implementing a 
recovery.

table: List of event log
GAM ID Severity Description Details Corrective action
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